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Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
MCP19114 - Flyback Stand-Alone Evaluation Board. Items discussed in this chapter 
include:

• Document Layout

• Conventions Used in this Guide

• Recommended Reading

• The Microchip Web Site

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to install the MCP19114 - Flyback Stand-Alone 
Evaluation Board. It also describes how to operate the Evaluation Board. The manual 
layout is as follows:

• Chapter 1. “Product Overview” – Important information about the MCP19114 - 
Flyback Stand-Alone Evaluation Board.

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with the MCP19114 - Flyback Stand-Alone Evaluation Board.

• Chapter 3. “Graphical User Interface (GUI)” – Includes instructions on the 
MCP19114-Flyback Standalone GUI.

• Appendix A. “Schematic and Layouts” – Shows the schematic and layout 
diagrams for the MCP19114 - Flyback Stand-Alone Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the 
MCP19114 - Flyback Stand-Alone Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user's guide describes how to use MCP19114 - Flyback Stand-Alone Evaluation 
Board. Other useful documents are listed below. The following Microchip documents 
are available and recommended as supplemental reference resources.

• MCP19114/5 Data Sheet – “Digitally Enhanced Power Analog Synchronous 
Low-Side PWM Controller” (DS20005281)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (March 2014)

• Initial Release of this Document.

http://www.microchip.com/support
http://www.microchip.com/support
www.microchip.com
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Chapter 1.  Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP19114 - Flyback Stand-Alone Evaluation 
Board and covers the following topics:

• MCP19114 Short Overview

• What is the MCP19114 - Flyback Stand-Alone Evaluation Board?

• MCP19114 - Flyback Stand-Alone Evaluation Board Kit Contents

1.2 MCP19114 SHORT OVERVIEW

The MCP19114 is a highly integrated, mixed-signal, analog pulse width-modulation 
(PWM) current mode controller with an integrated microcontroller core and offers syn-
chronous or asynchronous operation. Since the MCP19114 device uses traditional 
analog control circuitry to regulate the output current or voltage, the integration of the 
PIC® Microcontroller mid-range core is used to provide complete customization of the 
device’s operating parameters, protection levels, programmable offset, deadtimes, 
slope compensation and fault handling procedures.

The MCP19114 has two internal LDOs. A 5V LDO (VDD) provides internal power to all 
the digital circuitry and can supply limited external power at the VDD pin. A 4V LDO 
(AVDD) provides power to the internal analog circuitry and supplies the reference volt-
age to the ADC. This device features synchronous low-side integrated drivers and 
4k word non-volatile memory, all in a space-saving 24-pin 4mm x 4mm QFN package. 

Finally, to support traditional MOSFETs, pin 18 (VDR) is used to provide input power to 
the two low-side synchronous gate drivers. The evaluation board is populated with the 
Microchip TC1240A voltage doubler. Resistor population provides the option of 
powering VDR with 10V via the TC1240A voltage doubler (R19, R21 populated, R22 not 
populated) or 5V (R22 populated, R19, R21 not populated) gate-drive capability.

User firmware, including device configuration, is loaded using Microchip’s MPLAB X® 
- Integrated Development Environment (IDE). A graphical user’s interface (GUI) is 
used to communicate with and edit operating parameters of the MCP19114. The GUI 
communicates via I2C™ using the PICkit™ Serial Analyzer. 

The GUI offers the user the ability to adjust the programmable features available in the 
MCP19114. The GUI cannot stop the user from uploading incorrect settings to the 
device. Incorrect settings may have unintended consequences, including, but not lim-
ited to, unstable operation, damaging the load, and even damaging of the MCP19114 
device. It is the user's responsibility to understand the system effects of the parameters 
they enter.
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FIGURE 1-1: Typical MCP19114 Flyback Application – Two String LED Driver.

1.3 WHAT IS THE MCP19114 - FLYBACK STAND-ALONE EVALUATION BOARD?

The MCP19114 - Flyback Stand-Alone Evaluation Board is intended to demonstrate 
how the MCP19114 device operates in a synchronous flyback topology. It is configured 
to regulate load current and is also well-suited to drive LED loads. Nearly all operational 
and control system parameters are programmable by utilizing the integrated PIC 
Microcontroller core. 

The MCP19114 comes preprogrammed with firmware designed to operate with the 
GUI interface. MPLABX IDE software can be used to download user defined firmware, 
and thus tailoring it to their specific application.The evaluation board contains headers 
for In-Circuit Serial Programming™ (ICSP) as well as I2C communication. 

Several test points have been designed into the printed circuit board for easy access 
and development purposes. The MCP19114 - Flyback Stand-Alone Evaluation Board 
is also intended to demonstrate an optimized Printed Circuit Board (PCB) layout that 
minimizes parasitics while increasing efficiency and power density. Proper PCB layout 
is critical to achieve optimum MCP19114 operation as well as power train efficiency and 
noise minimization. MPLABX IDE, MCP19114 - Flyback Stand-Alone GUI and 
MCP19114 - Flyback Stand-Alone Firmware are available for download from 
Microchip’s web site. See Chapter 3. “Graphical User Interface (GUI)” for details.

1.4 MCP19114 - FLYBACK STAND-ALONE EVALUATION BOARD KIT 
CONTENTS

The MCP19114 - Flyback Stand-Alone Evaluation Board includes the following items:

• MCP19114 - Flyback Stand-Alone Evaluation Board (ADM00578)

• Important Information Sheet
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Chapter 2.  Installation and Operation

2.1 INTRODUCTION

2.1.1 MCP19114 - Flyback Stand-Alone Evaluation Board Features

The MCP19114 is a digitally-enhanced, power analog, synchronous low-side 
pulse-width modulation (PWM) controller. The graphical user interface was developed 
to assist users in easily configuring the MCP19114 and evaluating it in their target 
application.

The MCP19114 - Flyback Stand-Alone Evaluation Board is designed to operate from a 
single supply (nominal 8V to 14V, 24V maximum). The primary side MOSFET has a 
maximum VDS rating of 100V. Users should be cautious that this 100V rating is not 
exceeded when determining input and output conditions for their application. The 
coupled inductor has a 2:1 ratio. The secondary MOSFET has a 200V maximum VDS 
rating.

The default configuration provides the gate drive supply (VDR) with 10V. Adequate 
ceramic and bulk capacitors are supplied on the input to reduce the root mean square 
(RMS) ripple current and lessen input voltage deviation caused by load transients. 
Ceramic capacitors are also provided on the output to reduce voltage ripple and pro-
vide energy to the output while the primary side is being re-energized.

The MCP19114 - Flyback Stand-Alone Evaluation Board is fully assembled, pro-
grammed and tested to evaluate and demonstrate the MCP19114 operating perfor-
mance. Users will need to download and install the MCP19114 - Flyback Stand-Alone 
GUI from the Microchip website and become familiar with its operation before powering 
the MCP19114 - Flyback Stand-Alone Evaluation Board.

2.2 GETTING STARTED

2.2.1 Configuration Requirements

To power up and run the MCP19114 - Flyback Stand-Alone Evaluation Board, the 
following is required:

• MCP19114 - Flyback Stand-Alone GUI 
• MCP19114 - Flyback Stand-Alone Evaluation Board
• PICkit Serial Analyzer

2.2.2 Installing the MCP19114 - Flyback Stand-Alone GUI

Follow the steps to download and install the MCP19114 - Flyback Stand-Alone GUI:

1. Download the MCP19114 - Flyback Stand-Alone GUI software package from the 
Microchip web site. 

2. Extract the content of the archive files on the computer.

3. Double-click the setup.exe file to start software installation. Press the Install 
button in the Application Install window (Figure 2-1). Once the installation 
completes, the GUI window will open (see Figure 3-1 in Chapter 2. “Installation 
and Operation”).

Note: The factory-loaded firmware REQUIRES the use of the provided GUI to 
function. Without the GUI, the evaluation board will not operate. 
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FIGURE 2-1: MCP19114 - Flyback Stand-Alone GUI Installation Window.

2.2.3 Power Input and Output Connection

The MCP19114 comes programmed with generic firmware compatible with the 
standalone GUI. It is up to the user to modify or create new firmware dedicated to their 
stand-alone application if different functionality is required. 

2.2.3.1 APPLYING POWER

Use the VIN and GND Test Points as shown below. Nominal VIN is +8V to +14V with 
the Positive terminal (Red) connected to VIN and the Negative terminal (Black) 
connected to GND.

FIGURE 2-2: Applying Power to the Board.

Note: If the default firmware is modified, the GUI may no longer be compatible 
with the MCP19114 - Flyback Stand-Alone Evaluation Board. 

VOUT

GND

GND

VIN

CAUTION

The Primary side MOSFET is Rated to 100V. The transformer turns ratio is 1:2. Do Not 
exceed the 100V MOSFET Rating. Primary MOSFET (OFF) VDS = 0.5 x VOUT + VIN.
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2.2.4 Preprogrammed MCP19114 - Flyback Stand-Alone Evaluation 
Board

The MCP19114 - Flyback Stand-Alone Evaluation Board comes with preprogrammed 
firmware installed to operate with the GUI. To reprogram the device, the following tools 
are required:

• MPLAB X IDE (version 1.5 or later)

• MPLAB® XC8 C Compiler (v1.3 or later)

• MCP19114 - Flyback Stand-Alone Firmware

• MCP19114 - Flyback Stand-Alone Evaluation Board

• PICkit™ 3 In-Circuit Debugger/Programmer

Follow the steps to install all necessary software and start reprogramming the 
MCP19114 device:

1. If MPLAB X is already installed, go to Step 2. If not, download MPLAB X from: 
www.microchip.com/mplabx, and follow the MPLAB X installation instructions.

2. If an XC8 compatible C-compiler, or an equivalent, is already installed in 
MPLAB X, go to Step 3. If not, you can download a free version of Microchip's 
XC8 from: www.microchip.com/mplabxc. The XC8 user guide, installation 
instructions, and download links are available on this page.

3. Download the MCP19114 - Flyback Stand-Alone Firmware (*.zip) from 
www.microchip.com/mcp19114 under "Documentation & Software/Software".

4. Unzip the MCP19114 - Flyback Stand-Alone Firmware archive. Place the 
MCP19114 project folder in the desired folder location. 

5. Power up the MCP19114 - Flyback Stand-Alone Evaluation Board.

6. Connect the PICkit 3 In-Circuit Debugger to the MCP19114 - Flyback 
Stand-Alone Evaluation Board via the 6-pin connector J3, as seen in Figure 2-3 
(for more information about PICkit 3 In-Circuit Debugger refer to the “PICkit™ 3 
In-Circuit Debugger/Programmer User’s Guide For MPLAB® X IDE” - DS52116).

Note: When installed, MPLAB X IDE automatically creates a project folder. In 
Windows®, this folder can typically be found under 
drive\Users\user_name\MPLABXProjects.

www.microchip.com/mplabx
www.microchip.com/mplabx
www.microchip.com/mplabxc
www.microchip.com/mplabxc
www.microchip.com/mplabxc
www.microchip.com/mcp19114
www.microchip.com/mcp19114
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FIGURE 2-3: PICkit 3 In-Circuit Debugger/Programmer Connected to the 
MCP19114 - Flyback Stand-Alone Evaluation Board.

7. Open MPLAB X IDE to load MCP19114 - Flyback Stand-Alone Firmware. From 
the File menu select Open Project (Figure 2-4).

FIGURE 2-4: Opening Project in MPLAB X IDE.
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8. Browse for the location of the extracted firmware. Select the 
MCP19114_Stand_Alone from the list, then check the Open as Main Project 
option. Press the Open Project button to complete loading the file.

FIGURE 2-5: Loading Firmware into MPLAB X IDE.

9. Once the project is opened, click Make and Program Device Main Project 
button on the tool bar to program the device. Wait until the program process is 
complete.

FIGURE 2-6: Selecting and Executing the Make and Program Device Main Project in MPLAB X IDE.

Make and Program Device 
Main Project Button 

Programming/Verify Complete Result
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Chapter 3.  Graphical User Interface (GUI)

3.1 INTRODUCTION

The MCP19114 - Flyback Stand-Alone GUI requires a Windows® XP/7/8 operating 
system, a USB port and a minimum screen resolution of 1024 x 768. To run the 
software, follow the steps described in this section. 

1. Apply an input voltage in the normal operating range (8V to 14V) at the VIN and 
Ground test points.

2. Connect the PICkit Serial Analyzer to the PC via USB port and then connect the 
analyzer to the Control Board via the 6-pin serial connector J5 (Figure 3-1).

FIGURE 3-1: PICkit Serial Analyzer Connection to the Board.

3. To start the GUI, select Start > All Programs > Microchip Technology 
Inc. > MCP19114 Flyback Standalone GUI. The interface detects the 
MCP19114 device automatically and is ready for use (see Figure 3-2).
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FIGURE 3-2: MCP19114 - Flyback Stand-Alone GUI - Initial Screen.

3.2 CONFIGURING PARAMETERS

As depicted in Figure 3-2, the MCP19114 - Flyback Stand-Alone GUI is divided into four 
parts: 

• System Parameters 

• Register Online Adjust

• Control Buttons

• Operating Status Box

3.2.1 System Parameters

3.2.1.1 DRIVERS ENABLE/DISABLE

The Drivers Enable/Disable section defaults to OFF when starting the MCP19114 - 
Flyback Stand-Alone GUI. When this is set to ON, all other adjustable parameters 
become active for adjustment. When OFF is selected, the GUI will turn off the drivers 
and make all of the parameters unavailable for change so they cannot be altered. 

3.2.1.2 PARAMETERS

This section controls the Switching Frequency, Maximum Duty Cycle, Output Current 
and Current Sense Resistor parameters. The switching frequency is user 
programmable in Fixed Frequency mode over the range of 60 kHz to 1 MHz. Switching 
Frequency can be adjusted in 10 kHz intervals. The maximum duty cycle is 
programmable from 0 to 100%.

System
Parameters

Operating
Status Box

Control
Buttons

Register
Adjust Online
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Users can adjust the Output Current over a range of 0 to 500 mA. The Current Sense 
Resistor (R6) value on the MCP19114 - Flyback Stand-Alone Evaluation Board is 
200 m. Both of these values are used to calculate the set point value written to the 
VREFCON register. DO NOT raise the resistor value in the GUI without changing the 
resistor on the evaluation board to match. Failure to do so could result in damage to 
the evaluation board.

3.2.1.3 OPERATING MODE

This section controls whether the Flyback converter is operated in Fixed-Frequency, 
Quasi-Resonant, Synchronous or Asynchronous Modes. When running in Fixed 
Frequency mode, the switching frequency parameters are adjustable. The third button 
is for Synchronous Operation. When the EN ON button is selected on the GUI, the 
Synchronous Operation box is automatically selected by default, putting the evaluation 
board in Synchronous mode. If the Synchronous Operation box is unchecked, the 
evaluation board is set to Asynchronous operation which disables the secondary driver 
(SDRV).

FIGURE 3-3: Operating Mode Options.

3.2.1.4 PROTECTION

The Protection control allows the user to set levels for the three adjustable protection 
features. Input Voltage Under Voltage Lockout (VIUVLO), Input Voltage Overvoltage 
Lockout (VINOVLO) and Output Voltage Overvoltage (OV) can all be configured in this 
section of the GUI.

FIGURE 3-4: Protection Options.

CAUTION

Increasing switching frequency results in increased switching losses in the MOSFETs. 
It is the user's responsibility to ensure MOSFETs are operated within their safe 
operating range.

Note: Attempting to write a value larger than 0xFF to VREFCON is prohibited by 
the GUI.
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The VINUVLO and VINOVLO Protection parameters are configurable per their 
specified ranges. The specified range for VINUVLO is 4V to 20V. The default VINUVLO 
setting in the GUI is 8V. The specified VINOVLO range is 9V to 24V. The default 
VINOVLO setting in the GUI is 18V. The Output OV has a configurable range between 
0V and 60V. The default OV setting in the GUI is 40V. 

The LED (D2) on the evaluation board is used to indicate various fault conditions. The 
firmware will flash this LED to indicate each of the following fault conditions:

• VIN UVLO FAULT: Short Flash Routine

• VIN OVLO FAULT: Long Flash Routine

• OUTPUT OV FAULT: Short/Long Flash Routine

3.2.1.5 TEST PIN

This section of the GUI has a drop-down menu that allows users to select and connect 
test signals to GPIO GPA0. These signals are accessible at the test point labeled TEST. 
The Test Pin can be configured to output several analog or digital parameters. See 
Figure 3-5 for the list of signals.

FIGURE 3-5: Test Pin Options.

3.2.1.6 SWITCHES ENABLE/DISABLE

There are two general purpose MOSFET low-side series switches located on 
MCP19114 - Flyback Stand-Alone Evaluation Board (LSW1 and LSW2). The control 
boxes in the Switches Enable/Disable section of the GUI allow the user to turn these 
switches ON (checked) and OFF (unchecked).

WARNING 

Use caution when changing from these default settings to ensure that damage will not 
occur. The VINUVLO, VINOVLO and Output OV controls adjust the VINUVLO, VINOVLO 
and OVREFCON registers, respectively.
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3.2.1.7 ADVANCED REGISTER UPDATE

This section of GUI gives the user more options to configure and operate the 
MCP19114 - Flyback Stand-Alone Evaluation Board. The adjustable parameters 
include Leading Edge Blanking (LEB), Primary Driver (PDRV) Deadtime, Secondary 
Driver (SDRV) Deadtime, Input Current Offset and Slope Compensation. In addition, 
this section allows users to update up to four Special Function Registers (SFR) at the 
same time. For more information on Special Function Registers, refer to the 
MCP19114/5 Data Sheet – “Digitally Enhanced Power Analog Synchronous Low-Side 
PWM Controller” (DS20005281).

FIGURE 3-6: Advanced Register Update Options.

3.2.2 Register Online Adjust

The Register Online Adjust section of the GUI allows the user to have direct control of 
register values at any time when operating the MCP19114. The device data sheet con-
tains information on register address locations and content. Reads and writes are done 
in hexadecimal format. Users must select the proper bank, which is especially import-
ant when executing a write. It is good practice to always execute an address read 
before a write, to check for expected results. This may help prevent an unintended write 
to an improper address or bank. Please note that the Update button will not update this 
section.

FIGURE 3-7: Register Online Adjust Options.
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3.2.3 Control Buttons

The two buttons on the left are user selectable self-test options. The Initialize PICkit 
Serial button checks communication between your computer and PICkit Serial 
Analyzer. The Check for Evaluation Board can be selected by the user to manually 
ask software to detect the evaluation board. 

The Update button will apply the configuration settings made in Operating Mode, 
Parameters, Protection, Switches Enable/Disable, Advanced Register Update and will 
turn on the output drivers. It will not update the Register Online Adjust section.

The Turn Off Drivers button is a Master Stop that shuts off the output drivers. Pressing 
this button will disable both Primary and Secondary drivers. 

FIGURE 3-8: Control Buttons.

3.2.4 Operating Status Box

This box provides messages to the user and operating status. Examples of status mes-
sages are shown in Figure 3-9.

FIGURE 3-9: Operating Status Box.
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Appendix A. Schematic and Layouts

A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP19114 - 
Flyback Stand-Alone Evaluation Board:

• Board – Schematic

• Board – Top Layer

• Board – Top Copper

• Board – Mid Layer 1

• Board – Mid Layer 2

• Board – Bottom Copper

• Board – Bottom Layer
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A.2 BOARD – SCHEMATIC
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A.3 BOARD – TOP LAYER



MCP19114 - Flyback Stand-Alone Evaluation Board User’s Guide

DS50002255A-page 28  2014 Microchip Technology Inc.

A.4 BOARD – TOP COPPER
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A.5 BOARD – MID LAYER 1
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A.6 BOARD – MID LAYER 2
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A.7 BOARD – BOTTOM COPPER
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A.8 BOARD – BOTTOM LAYER
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Appendix B. Bill of Materials (BOM)

TABLE 2-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

4 4-40 screw Machine screw 4-40 1/4 B&F™ Fasteners Supply PMSSS 440 0025 PH

4 4-40 
standoff 1/4

Hex standoff 4-40 aluminum1/4 Keystone Electronics 2201

4 C1, C2, 
C9, C10

DO NOT POPULATE — —

1 C3 Cap. ceramic 1 µF, 100V, X7R, Auto 1206 TDK Corporation CGA5L2X7R2A105M/SOFT

2 C4, C5 Cap. ceramic 10 µF, 50V, X7R, Auto 1210 Taiyo Yuden Co., Ltd. UMK325AB7106MM-T

2 C6, C11 Cap. ceramic 2.2 µF, 50V, X7R, Auto 1206 TDK Corporation CGA5L3X7R1H225K

1 C7 Cap. ceramic 4.7 µF, 50V, X7R, Auto 1206 TDK Corporation C3216X7R1H475K160AC

1 C8 Cap. ceramic 3.3 µF, 50V, X7R, Auto 1206 TDK Corporation C3216X7R1H335K160AC

2 C12, C20 Cap. ceramic 1 µF, 25V, X7R, Auto 0603 TDK Corporation CGA3E1X7R1E105K

2 C13, C14 DO NOT POPULATE — —

2 C15, C16 Cap. ceramic 4.7 µF, 16V, X5R, Auto 0603 TDK Corporation C1608X5R1C475K

1 C17 Cap. ceramic 220 pF, 50V, COG 0603 Murata Electronics® GCM1885C1H221JA16D

1 C18 Cap. ceramic 1 nF, 50V, COG 0603 Murata Electronics® GCM1885C1H102JA16D

1 C19 Cap. ceramic 10 nF 50V 10% X7R 0603 TDK Corporation C1608X7R1H103K080AA

1 C21 Cap. ceramic 0.1 µF, 50V, X7R, Auto 0603 TDK Corporation CGA3E2X7R1H104K

1 D1A, D1B Diode SW DBL 200V 225 mA SOT143B NXP Semiconductor BAV23, 215"

1 D2 LED, super red, clear 0603 Lite-On® Technology 
Corporation 

LTST-C190KRKT

1 D3 TVS diode 90 VWM 146 VC SMA Uni-Dir Littelfuse® SMAJ90A

2 J3,J5 Header, 6   Pos., 2.54 mm, SMT, vert., gold Samtec, Inc. TSM-106-01-L-SV

1 PCB Printed Circuit Board - MCP19114 - 
Flyback Stand-Alone Evaluation Board

— 04-10290

3 Q1, Q3, Q4 N-Channel MOSFET, 100V Vishay 
Intertechnology, Inc.

SIS890DN-T1-GE3

1 Q2 MOSFET N-Ch. 200V 15.2A 
8TSDSON

Infineon 
Technologies AG

BSZ900N20NS3 G

2 R1, R2 Res. 3.92 k 1/10th Watt, 1% 0603 
SMD

Panasonic® - ECG ERJ-3EKF3921V

6 R3, R5, R15, 
R16, R17, 
R21

Res. 0.0 1/10W 0603 SMD Panasonic - ECG ERJ-3GEY0R00V

1 R4 Res. 50 m 1 Watt, 1% 0612 SMD Susumu Co., LTD. PRL1632-R050-F-T1

1 R6 Res. 200 m 1 Watt, 1% 0612 SMD Rohm Semiconductor LTR18EZPFLR200

1 R7 Res. 100 k 1/10th Watt, 1% 0603 SMD Panasonic - ECG ERJ-3EKF1003V

1 R8 DO NOT POPULATE — —

1 R9 Res. 4.02 k 1/10th Watt, 1% 0603 SMD Panasonic - ECG ERJ-3EKF4021V

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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4 R10, R12, 
R13, R14

Res. 10 k 1/10th Watt, 1% 0603 SMD Panasonic - ECG ERJ-3EKF1002V

1 R11 Res. 1.02 k 1/10th Watt, 1% 0603 SMD Panasonic - ECG ERJ-3EKF1021V

1 R18 Res. 475 1/10th Watt, 1% 0603 SMD Panasonic - ECG ERJ-3EKF4750V

1 R19 Res. 10.0 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF10R0V

1 R22 DO NOT POPULATE — —

1 R23 Res. 10 k1/10th Watt, 1% 0603 SMD Panasonic - ECG ERJ-3EKF1002V

1 T1 Uni-Cuk Transformer 1:2 Wurth® Group 750341878

1 U1 Digitally Enhanced PWM Power 
Analog Controller

Microchip 
Technology Inc.

MCP19114-E/MJ

1 U2 Charge Pump, Doubler Microchip 
Technology Inc.

TC1240A-E/CH

6 VIN, PGND, 
PGND1, 
VOUT, 
LSW1, LSW2

Test point PC compact SMT Keystone 
Electronics Corp.

5016

TABLE 2-1: BILL OF MATERIALS (BOM) (CONTINUED)

Qty. Reference Description Manufacturer Part Number

Note 1: The components listed in this Bill of Materials are representative of the PCB assembly. The 
released BOM used in manufacturing uses all RoHS-compliant components.
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NOTES:
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Компания «ЭлектроПласт» предлагает заключение долгосрочных отношений при 
поставках импортных электронных компонентов на взаимовыгодных условиях! 

 
Наши преимущества: 

 Оперативные поставки широкого спектра электронных компонентов отечественного и 
импортного производства напрямую от производителей и с крупнейших мировых 
складов; 

  Поставка более 17-ти миллионов наименований электронных компонентов; 

 Поставка сложных, дефицитных, либо снятых с производства позиций; 

 Оперативные сроки поставки под заказ (от 5 рабочих дней); 

 Экспресс доставка в любую точку России; 

 Техническая поддержка проекта, помощь в подборе аналогов, поставка прототипов; 

 Система менеджмента качества сертифицирована по Международному стандарту ISO 
9001; 

 Лицензия ФСБ на осуществление работ с использованием сведений, составляющих 
государственную тайну; 

 Поставка специализированных компонентов (Xilinx, Altera, Analog Devices, Intersil, 
Interpoint, Microsemi, Aeroflex, Peregrine, Syfer, Eurofarad, Texas Instrument, Miteq, 
Cobham, E2V, MA-COM, Hittite, Mini-Circuits,General Dynamics и др.); 
 

Помимо этого, одним из направлений компании «ЭлектроПласт» является направление 
«Источники питания». Мы предлагаем Вам помощь Конструкторского отдела: 

 Подбор оптимального решения, техническое обоснование при выборе компонента; 

 Подбор аналогов; 

 Консультации по применению компонента; 

 Поставка образцов и прототипов; 

 Техническая поддержка проекта; 

 Защита от снятия компонента с производства. 
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Факс: 8 (812) 320-02-42  
Электронная почта: org@eplast1.ru  

Адрес: 198099, г. Санкт-Петербург, ул. Калинина, 

дом 2, корпус 4, литера А.  
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